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Abstract 

There are many methods available for developing profiles of gear and spline 

teeth.  Most of the techniques are inaccurate because they use only an 

approximation of the involute curve profile. The parametric method 

developed in this paper provides accurate involute curve creation using 

formulas and exact geometric equations.  In addition, the involute curve by 

equation technique allows using either Cartesian in terms of X, Y, and Z or 

cylindrical coordinate systems to create the involute curve profile.  Since 

spur gear geometry is controlled by a few basic parameters, a generic gear 

can be designed by three common parameters namely the pressure angle (a), 

the module (m), and the number of teeth (z).  Most of the present day CAD 

systems have no built-in tool for designing such gears.  This paper is an 

attempt in utilizing the concept of parametric technology to develop a 

template gear.  The gear so developed has true involute profile, which is a 

realistic design. This will allow making changes to the gear design by using 
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parametric input.   If one gear file is developed using this parametric 

technology, with which, different size and variety of spur gears can be 

created.  The specific objective is to design and develop a template spur gear 

with 3 module, 30 Teeth, 20° pressure angle based on parametric technique 

by using CATIA V5R14 package.  The later portion it is shown how this 

model may be retrieved and utilized for developing gears of different modules 

and number of teeth with change in these input parameters. 

 

Keywords:  Parametric design, Template gear, involute curve, x and y co-
ordinates, Laws for x and y co-ordinates, Extrapolated spline, circular 
pattern, extrusion 
 

Introduction 

Template gear development using parametric method means that the 
dimensions control the shape and size of the gear.   The template gear should 
have the ability to be modified, and yet remain in a way that retains the 
original design intent.  The logical modifications which can be carried out 
will be the number of teeth and module. Since the design is parametric it is 
possible to create a variety of spur from one model (Earnest L. Walker and  
Bruce Cox, 1999).    The involute gear is based on an involute curve, which 
is a mathematical shape.  The involute profile is the path traced by 
unwrapping a string that is wound over a cylinder by maintaining its tension.  
There are many methods available in creating the involute profile.  Method 1 
is purely based on geometrical construction and is concerned in preparing the 
teeth profile individually for all the teeth in the gear, this takes longer time to 
complete the total profile of the gear and Method 2 is  preparing one profile 
and by keeping this as template the other profiles are created.  This method is 
adequate when ordinary representation of the gear is needed and not an 
accurate one.  The third method and the most accurate system is the graphic 
method of drawing the involute.  Though the procedure is laborious, it can be 
used for creating the uncorrected and corrected gear profiles.  This could be 
also employed in developing form tools. (Gitin M. Maitra, 2000).  Excel 
Spreadsheet can also be used to draw gears quickly and easily, it will be very 
useful in creating sets of gears for any projects that require accurate shapes 
and rapid prototyping of interlocking gears. Excel is a common program.  
The shortcomings are that any adjustments to the design cannot be 
immediately reflected in the program where the profile is generated.   Instead, 
the new parameters must be entered into the Excel sheet, and then transferred 
to a plot file.   It also needs to provide a visualization of what the new gear 
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will look like, which needs an extra step in the HPGL/1 file transfer before 
the design becomes an actual model.  (Joseph B. Ferreira, 2002) 
 

Methodology 

The methodology starts with study (Olberg, Erik, Jones et al;2000) and 
tabulating the mathematical relation for generating the involute profile and 
other parameters for the standard gear (Dudley, Darle W, 1984).  The 
generative shape design work bench in CATIA V5R14 , is selected to create 
the geometrical set for the gear.  The present work bench is configured for 
relations, parameters and metric units.  The ZY plane (front) is selected for 
geometry creation.  The f(x) icon is used to enter the primary generation 
parameters like module (m), Pressure angle (a), and the number of teeths (z).  
Followed which the dependant parameters like pitch circle radius (rp), base 
circle radius (rb), outer circle radius (ra), the root circle radius (rf), root fillet 
radius (rc) are keyed in.  The fog command is activated and the parametric 
laws of Yd and Zd and entered.  The origin point and axis along x direction is 
created.  The Yd and Zd co-ordinates are referred from the parametric laws 
and a set of points P2 to P5 is created in the ZY plane.  Joining these points 
creates the spline, which then is extrapolated towards the center.  The 
extrapolated spline now is rotated to produce the symmetry of the profile 
with reference to ZX plane.  The semi circle representing the outer and the 
root cirle is drawn.  Create fillet radius at the root using the corner option.  
The split command is activated to prepare the portion of the profile, for this 
the outer circle, extrapolated spline and corner is used.  Then the involute is 
mirrored using the symmetry option.  The top land and other portions of the 
profile is created and joined as one profile using join option.  Further, the 
profile is patterned using the circular pattern from the advanced repletion 
tools.   The final gear profile is extruded using the pad option in the part 
workbench.  The bore and keyway if necessary may be created.  The table 1 
contains the parameters and formulas used in the parametric definition of 
gear in the software.  The gear is developed in the metric system (Dan 
Marsalek, 2005).  
 
S1:   Start and configure the generative shape design workshop:  Since the 

part design workshop is not sufficient for designing parametric curves, 

select the generative shape design workshop Generative shape design: 
Start > Shape> Generative shape Design  
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S2:  After CATIA program is initiated – select TOOLS>OPTIONS- 
>infrastructure > part infrastructure and in Display select Parameters and 
Relations.    

 

S3:  Then in Options>General in Parameters and Measures select with value 
and with formula in Parameters Tree View. Click ok.   Bring the knowledge 

tool bar outside  

 

S4: Click on arrow pointed down near table icon.  Fog and f(x) are two 

most important things you will use for gear design                                                      

S5:  Entering the parameters – The Module (m), number of teeth (z), 

Pressure Angle (a) Enter some basic parameters that define gear. This is done 

by clicking at f(x) icon Fig 2.  and then when you see dialog box: Formulas: 

3 x 30 Spur gear.   In the new parameters tab select (real, length or angle) and 

click it, and then edit value Fig 3. This is done until all parameters are 

entered.  
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     P Formula Description/ Units used for construction 

a 20deg 
Pressure angle: technologic constant 
(10deg ≤ a ≤ 20deg) / Angular degree 

m —  Modulue / millimeter 

Z — Number of teeth (5 ≤ Z ≤ 200) / Integer 

p m * π 
Pitch of the teeth on a straight generative rack / 
millimeter 

e p / 2 
Circular tooth thickness, measured on the pitch 
circle / millimeter 

ha m 
Addendum = height of a tooth above the pitch circle 
/ millimeter 

hf 
if            m > 1.25 
       hf = m * 1.25 
else hf = m * 1.4 

Dedendum = depth of a tooth below the pitch circle. 
Proportionally greater for a small modulus (≤ 1.25 
mm) / millimeter 

rp m * Z / 2 Radius of the pitch circle  / millimeter 

ra rp + ha Radius of the outer circle / millimeter 

rf rp - hf Radius of the root circle. / millimeter 

rb rp * cos( a ) Radius of the base circle  /millimeter 

rc m * 0.38 
Radius of the root concave corner. 
(m * 0.38) is a normative formula  / millimeter 

t 0 ≤ t ≤ 1 
Sweep parameter of the involute curve  / floating 
point 
number 

yd 
rb * ( sin(t * π)  
- cos(t * π) * t * π ) 

Y coordinate of the involute tooth profile, generated 
by the t parameter / millimeter 

zd 
rb * ( cos(t * π)  
+ sin(t * π) * t * π )  

Z coordinate of the involute tooth profile / 
millimeter 

ro rb * a * π / 180deg 
Radius of the osculating circle of 
the involute curve, on the pitch circle  / millimeter 

c 
sqrt( 1 / cos( a )2 - 1 ) / 
PI * 180deg 

Angle of the point of the involute 
that intersects the pitch circle / angular degree 

phi 
atan(  yd(c) /  
zd(c) ) + 90deg / Z 

Rotation angle used for making a gear symmetric to 
the ZX plane  / angular degree 
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Fig 1 Parametric spur gear – Development Method Table 1:  
 
 
 
 

 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

• Configure the generative shape design workshop 

• Enter the parameters and formulas 

• Define the primary generation       parameters 

• Define dependent parameters 

• Check the primary and computed parameters 

• Parametric laws of the involute curve 

• Create  geometric body and insert geometric elements 

• Make the geometric profile of the first        tooth 

• Define the parameters, constants and formulas 

• Insert a set of 5 constructive points and connect them with a spline 

• Extrapolate the spline toward the center of the gear 

• Rotate the involute curve for the symmetry relative to the ZX plane 

• Draw the outer circle and the root circle 

• Insert a rounded corner near the root circle 

• Create the rounded corner of the next tooth 

• Assemble the different elements of the first tooth 

• Build the whole gear profile and extrude it 

  Cut the gear wheel 

  Check the parametric generation 

• Study and tabulate the mathematical formula for gear parameters and 

involute generation 
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S6:  Entering the formula rb - base cylinder radius, rp - Pitch circle radius, 

ra - outside circle radius, rf - root circle radius, rc – bottom clearance.  Enter 

the formula for, rp, ra, rb, rk and rc by naming them and by clicking Add 

Formula. Formula editor will appear:  Enter: rp = m*z/2, Enter: rb = r*cos(a), 

Enter: rf = r – 1.25 *m, Enter: ra = r + m*1, After entering all formulas and 

expanding specification tree and look for the created parameter as in Fig 4. 

 

S7:  Preparing the Geometric profile of the first gear tooth: Since the 

whole gear is the circular repletion of the first tooth, the profile of first tooth 

is developed initially. 

 

S7a. Parametric laws of Involute curve:  Define the formulas defining the 

(Y, Z) Cartesian position of the points on the involute curve of a tooth.  We 

could as well define a set of parameters Y0, Z0, Y1, Z1, … for the 

coordinates of the involute's points.  Add laws that will define the involute of 

the gear Fig 5. Click on fog icon, name law as yd > select ok > add 

parameters, t – select real, and x - length select their types and apply > ok. 

Refer Fig 6. 

Law yd: yd=rb*(sin (t*PI*1rad)-cos (t*PI*1rad)* t*PI (1)       

 

S7b:  Same should be done for zd. This law will helps to create points that 

define spline for our involute.  Involute is line that is trajectory of point 

belonging to line that is always tangent to base gear cylinder. It is used for 

tooth profile.  If gears had profiles formed by straight lines they wouldn't 

work.  

Law zd:zd= rb*( cos (t*PI*1rad )+sin (t*PI*1rad )*t*PI (2) 

    

S8:  Creating geometric profile for the first tooth: The position of each 
point is defined by the yd (t) and zd (t) parametric laws.  5 points are defined 
on the YZ plane.  Insert > Wireframe> Point> Select point type: on plane> 
Select YZ plane > for position Y and Z, right click and Edit formula. In order to apply the involute formulas, edit the Y and Z coordinate of
ordinate, double click the Relations\Zd .Evalutae(0).  Click on the spline 

icon    and connect all points.  Check for the spline profile on the screen.              
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S8a: Extrapolating the spline towards the center of the gear:  The 
extrapolation is required because the  involute curve ends on the base circle 
of radius rb = rp * cos(20) = rp * 0.94.   When Z < 42, the root circle is 
smaller than the base circle. For example, when Z = 25: rf = rp - hf = rp - 
1.25 * m = rp * (1 - 2.5 / Z) = rp * 0.9. So the involute curve must be 
extrapolated for joining the root circle. Fig 8. 

Click on the Extrapolate icon in the extrapolate dialog box key in point 2 
for the boundary point and extrapolated spline.1.  The length of extrapolation 
is empirically defined as f(x)= 2*m The continuity should be selected as 
curvature.  
 

S9: The involute curve is rotated for the symmetry relative to the ZX 
plane: The rotation angle is decided by formula 18, from table.  Before this 
the value of c, the involute parameter is entered from the formula 17. 
c=sqrt(1/(cos(a)*cos(a))-1)/PI, and the unit should be selected as real. Phi = 

atan (Relations\yd .Evaluate(c)/Relations\zd .Evaluate(c))+90deg/z.  

Rotate the Extrapolated spline through an angle –Phi.  Fig 9.  The points and 
spline can be hidden by right click on the point menu and select hide/show 
menu.  The outer circle, root circle is drawn.   
 

S9a: Inserting a rounded corner near the root circle:  The corner between 
the extrapolated involute curve and the root circle has a radius defined by the  
parameter rc. Catia prompts to select an arc (in red) out of 4 possible 
geometric solutions (in blue).  Refer Fig 10 
 

S10:  Assemble the different elements of the first tooth:  At this assembly 
stage the extrapolated spline has to be cut, fill and join the different elements 
of the 1st tooth:  Cut the segment of the extrapolated spline between the outer 
circle and the rounded corner.  The symmetric profile is defined relative to 
the ZX plane, for the other side of the 1st tooth.   
S10a:  Inserting a new plane:  Insert>plane >plane type > Angle/Normal to 
plane> Select rotation axis > Reference plane as ZX plane > Angle is – 
PHI>ok.   Then the corner fillet radius is mirrored with respect to the plane 1.  

 

S10b:  The profile is trimmed with reference to the outer circle and root 
circle.    The corners are joined by line definition.   .  The last operation 
consists in joining all the elements of the 1st tooth.  The output looks like Fig. 

11 
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S11. To build the whole gear profile and to extrude it:  Since the gear profile 
is just a circular repetition of the 1st tooth, repetition around the X axis is 
defined.  The number of instances is controlled by the Z parameter (number of 
teeth).  Insert > Advanced repetition tools > circular pattern .  The circular 
pattern is defined as in the dialog box of Fig 12.  The completed gear profile is 
as seen in Fig 13. 

The part design workshop is opened and the pad option is used to 
extrude the gear profile.  The template output is as seen in the Fig 14.        
 

Results and Discussion 
This paper has aimed in developing a template spur gear, using parametric 
design.  The template gear is now used to develop Gear models of modules, 
number of teeth and other parameters.  Successfully developed gear is named as 
template gear.  Using this gear, we can generate gears of different parameters, 
which is tried using case studies.  Case 1:  In this case we try to model gear 
with the parameters 2 module 30 teeth with 14.5 degree pressure angle.  The 
template gear tree and the modified gear tree is shown aside each other. The 
final output generated is shown in Fig 15. Case 2:  Here 4 module, 30 teeth 
with 20 degree pressure angle gear is considered for development.  As above, 
the tree is shown and the output is shown in Fig 16.  From the above two case 
studies, we could conclude that that the parametric modeling technique helps to 
shorten the modeling time, and avoids the laborious work carried out in 
creating the gears.  The parametric concept can be extended for developing 
helical, bevel, and internal gears.  Computer-aided machining, inspection, 
sterolithography, Stress, motion Analysis, and similar such process that can use 
a three-dimensional part directly from a parametric solid modeled gear file.  
Since models are developed from the template the time consumed for modeling 
of gear each and every time based on the parameters assigned is reduced.  
Infact few entries in the input screen develops the gear in no time.  Cost of 
development of the model is lesser because of time.  The human fatigue is also 
very less.  Similar such concept with little modification can be utilized for 
developing asymmetric profiles and gears. 
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Fig 2: knowledge tool bar                 Fig 3. Entering the parameters 
 

 

 

 
 
 
 
 
 
 
 
 
 

 

Fig 4. Display of parameters               Fig5: Law editor yd 

 

 

 

  

African Research Review Vol. 3 (2), January, 2009. Pp. 415-429 



Copyright: IAARR, 2009 www.afrrevjo.com 425 

Indexed African Journals Online: www.ajol.info 

 

 

Fig 6:  Law editor yd active                                    Fig 7. Point Definition 

 

 

 

 

 

 

 

 

 

 

 

 

 

Fig 8. Extrapolated spline                       Fig 9.  Rotated spline 

 

            

 

 

 

 

 

 

 

 

 

 

Fig 10. Rounded corner                               Fig 11. The output of S10       
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Fig 12. Circular pattern                            Fig 13:  The total Gear profile   
 

 
 
   
 
 
 
 
 
 
 
 
 

 Fig 14:  The template Gear (Extruded output)   
 
 
 

 
 

 
 
 
 
 
 

Fig 16:  Development of gear with 4 module, 30 teeth gear with 14.5degree 
pressure angle 30 teeth gear with 20 degree pressure angle 

Fig 15: Development of gear 

with 2 module 
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Conclusion and Limitations   

This paper has attempted for how template gear could be developed. As such, 
template gear development is time consuming and it warrants sufficient skill 
and through understanding of the gear terminology.  The developed template 
has limitations that it can be utilized only in places where the gears are 
uncorrected.  When the gear design has modifications such as addendum, 
dedundum or proturberance etc., it would further complicate the template 
modeling. 
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Table 1: t-test analysis of the pretest scores of students taught with linguistic-
stylistic technique and traditional method. 

Method N  
 X 

S.D. DF t-cal. t-
critical 

Decision at 
P<.05 

Linguistic-
stylistic  

153 10.24 3.96 308 0.96 1.96 NS 

Traditional  157 10.68 4.08     

NS = Not Significant 
 
Table 2: t-test of the posttest mean scores on the academic achievement of 
students in poetry taught with linguistic-stylistic technique and traditional 
method. 

Method N  
 X 

S.D. DF t-cal. t-
critical 

Decision at 
P<.05 

Linguistic-
stylistic  

153 42.65 4.12 308 13.44 1.96 * 

Traditional  157 36.47 3.98     

*= Significant 
 
 
Table 3: t-test of the retention test mean scores on the academic achievement 
of students in poetry taught with linguistic-stylistic technique and traditional 
method.  

Method N  
 X 

S.D. DF t-cal t-
critical 

Decision 
at P<.05 

Linguistic-
stylistic  

153 43.86 4.08 30.8 16.27 1.96 * 

Traditional  157 36.54 3.87     

*= Significant 
 
Table 4: t-analysis of academic achievement of male and female students 
taught with linguistic-stylistic technique. 

Gender N  
 X 

S.D. DF t-cal. t-
critical 

Decision 
at P<.05 

Male  75 42.20 4.02 151 1.34 1.96 NS 
Female 78 43.10 4.22     

NS = Not significant  
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